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1 Wave Buoy Measurement 

Waverider buoys contain an accelerometer to measure the vertical acceleration as the buoy moves up and 
down with the water surface.  By integrating this acceleration with time received from an internal clock, the 
Waverider buoy provides an instantaneous reading of relative water level around a 2000cm mean.  Similarly, 
in a Directional Waverider buoy, separate accelerometers are used to measure the horizontal accelerations 
as the buoy moves sideways with the waves. 
 
As wave periods increase, the acceleration caused by a given wave height becomes lower.  This decreased 
acceleration makes it more difficult for the accelerometer to accurately measure the acceleration, and 
therefore the instantaneous water level change caused by longer period waves.  Due to this, there is a 
natural drop off in the response (accuracy) of a Waverider buoy as wave periods increase, particularly 
noticeable with periods greater than 20 seconds. 
 
Conversely, the Waverider buoy in water has a natural frequency around 1 second, causing the buoy to 
overestimate the instantaneous wave caused accelerations around this period, and therefore the associated 
instantaneous water level changes.  This is generally not a major problem as waves in coastal and estuarine 
areas usually quickly develop a period of at least 2 seconds. 
 
These two effects can be seen in the transfer function figure provided by Datawell, shown below (Waverider 
f1 Information Sheet, Datawell, 1979). 
 
 

 
 
Further details on the mechanical and electrical operation of Waverider buoys may be found in the 
Waverider buoy manual.
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Waverider Buoy Performance Degradation 
The Waverider buoy vertical accelerometer is mounted on a disk sitting in a high viscosity liquid.  Readings 
from the accelerometer are transferred to the buoy electronics for conversion to a water level via three thin 
wires.  These three wires also act as a suspension system for the disk, allowing it to move in the liquid 
relative to the container holding the liquid, while the liquid and disk damp the movement of the accelerometer 
so that it does not continue to move after the wave caused acceleration has changed (similar to shock 
absorbers in a car suspension system). 
 
Over deployed time, the viscosity of the liquid starts to break down, causing the buoy’s response to 
deteriorate as the damping decreases and the accelerometer continues to react to past wave accelerations.  
This generally manifests as the buoy reporting proportionally large amounts of low frequency wave energy 
(<0.05Hz) during times of low wave energy.  At this stage, the buoys can still be used to provide accurate 
wave data in high energy conditions (eg offshore locations), however they cannot be used in low locations 
where low energy conditions are expected. 
 
As degradation continued, the accelerometer eventually completely fails.  The accelerometer cannot be 
repaired and the cost cutting up the buoy, removing the accelerometer and then installing a new sensor is 
usually close to or more than the price of a new buoy. 
 
An alternative issue which can occur is that the buoy is spun too quickly so that the three thin suspension 
wires become entangled, introducing oscillations into the suspended platform.  This occurs because the 
damping of the liquid does not allow the disk to rotate as fast as the buoy if the buoy is spun too quickly.  
This manifests in a similar way to degraded suspension liquid, with proportionally large amounts of low 
frequency wave energy at around 40 seconds. 
 
It should be noted that the latest Waverider buoys have a new suspension which by its design has 
introduced a small amount of low frequency energy.  As these buoys have not been deployed for an 
extended period, it is possible that evidence of performance degradation in these buoys will be different. 
 
Acceptable Values for Waverider Performance 
As can be seen from the figure above, it can be acceptable for a buoy to under report wave height by 30%, 
or over report wave height by 200%, depending on wave frequency.  Due to this, a specific fixed accuracy 
value (eg 5% of actual wave height) cannot be set as the allowable limit before a buoy is determined to be 
“out of calibration”. 
 
Datawell claim that once wave heights have been corrected using the transfer function in the figure above, 
Waverider buoys have an accuracy of 3%.  This may be used as the basis for deciding whether a Waverider 
buoy is within acceptable limits, however an additional allowance for the long term degradation of the buoy 
components, say 2%, should be included. 
 
It is also important to note that while an older buoy may start to report incorrect long period wave energy 
during low energy wave conditions, this buoy will still provide accurate data in high energy wave conditions.  
Due to this, the particular nature of a any issues detected during a calibration should be considered when 
deciding on what should happen with a particular buoy. 
 
In practice, while the response of a Waverider buoy does degrade over time, this is generally due to breaking 
down of the viscous fluid inside the accelerometer.  The buoy usually maintains an acceptable response up 
until the accelerometer fails suddenly and completely.  While the degradation of performance may be seen 
over time by comparing successive calibrations of a particular buoy, it is difficult to predict failure. 
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Wave Analysis 
As ocean waves are comprised of a series of waves with slightly different periods and heights, rather than a 
set of uniform sinusoidal waves, no single value accurately describes the instantaneous wave height and 
period at a set location.  Due to this, a number of different output parameters are generally calculated using 
some form of statistical analysis.  A limitation of any statistical analysis is that confidence in the accuracy of 
the calculated parameters increases with the amount of collected data.  Analysis of ocean waves is 
complicated by the fact that they can change relatively quickly depending on the local conditions, such as 
wind.  This provides an upper limit on the length of time data is collected for to ensure that the waves within 
the data set are not changing.  In addition, operations personnel usually prefer data being updated relatively 
frequently so they are sure they are seeing the “real time” data. 
 
To address these competing issues, Cardno’s software conducts an “overlap” analysis.  This process is most 
easily understood through an example.   

- For the Bureau of Meteorology real time wave data, 4096 individual data points are collected at 
1/2.56Hz (just over 26 minutes of data) before an analysis is conducted.  This provides a large 
enough data sample to be confident in the results, while being short enough that the wave conditions 
being measured will generally not have changed an appreciable amount.  In line with World 
Meteorological Organisation standards for most other parameters, the results of the analysis are 
reported at the next 10 minute time interval.  This means that one data collection and analysis cycle, 
which starts at one 10 minute time interval, takes 30 minutes.   

- Rather than waiting for one analysis to be completed before starting to collect data for the next 
analysis, (and therefore providing an updated analysis every 30 minutes), the last 7 minutes of data 
from the previous analysis is included in the next analysis.  This means that only an additional 10 
minutes of data needs to be collected before the next analysis can be conducted. 

 
This overlap data collection scheme allows a larger amount of data to be collected, while maintaining the 
update frequency expected by the operators. 
 
Statistical analysis techniques for ocean waves have been developed over many years for different 
purposes, to the point where there are now many different parameters to describe both wave height and 
period. For non-directional waves, Cardno’s wave analysis conducts two separate analyses and reports 164 
different wave parameters, including 7 different periods and 6 different wave heights.  The two analyses are: 

- Time Domain analysis.  A mean water level is calculated from all of the data, which is then removed 
from the data.  Starting from the beginning of the record, an algorithm steps through the modified 
data to find when values change from negative to positive (zero crossing), as well as the lowest 
(trough) and highest (crest) levels between zero crossings. The troughs and crests are used to 
calculate wave heights, while the time between zero crossings is used to calculate periods. 

- Frequency Domain or Spectral Analysis.  This is done using a fast fourier transform technique, 
essentially attempting to match a series of sine waves with different periods, to the recorded data.  
Sine waves that match the data well report a larger amplitude while those that don’t match the data 
report lower amplitude.  Data from a frequency domain analysis is usually plotted as Energy vs 
Frequency (see below), with wave heights usually calculated based on the area under the line, and 
periods based on peaks in the energy (eg TP) or weighted average energy. 

 
 
As different parameters are used for different purposes, there is no single wave height or wave period 
parameter that is correct and covers all situations.  Following are three examples of the use of different wave 
parameters: 
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A coastal engineer designing a breakwater is interested in a number of different wave height parameters 
including: 

- To size armour, they may required the overall energy contained in the waves, best described by a 
parameter called HM0, the total area under the Energy vs Frequency curve from a frequency domain 
analysis, 

- To determine if the breakwater will be overtopped, the maximum wave height, HMax, calculated from 
a time domain analysis. 

 
A naval architect reviewing underkeel clearance for a large vessel is interested in wave parameters split into 
specific wave period bands and calculated from a frequency domain analysis: 

- <5-7 seconds – generally too small to affect a large vessel, 
- 7-100 seconds – will cause a large ship to heave, pitch and roll, 
- >100 seconds – too long to cause pitch and roll, but a large ship will heave. 

 
A ship, platform or shore observer who has been asked to provide an estimate of wave height will be 
observing waves in the time domain: 

- A human observer will generally overestimate the “average” wave height as they tend to ignore the 
smaller waves.  Due to this, human observers generally report significant wave height (HS).  In a 
computer based analysis, this is calculated as being the average height of the highest 1/3 of all 
measured waves. 

- While ignoring smaller waves for estimating wave height, a human observer will generally include all 
waves when estimating wave period.  Due to this, a human observer tends to report the average 
period of all the waves that occur, referred to as the zero crossing period (TZ). 
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2 Wave Buoy Calibration Software 

2.1 Calibration Software Implementation 

 
Due to the wide variety of different wave parameters and the fact that some inherently only reflect larger 
waves (eg HS) and longer periods (eg TP – period with peak energy), it is important to choose the correct 
wave parameters when conducting a Waverider buoy calibration.  With most wave shaped measurements 
(eg AC electricity, sound waves), the Root Mean Square wave amplitude (HRMS) over a series of waves is 
used as a measure of the average wave height and performance of wave generating capacity (eg power 
supplies).  For Waverider calibrations, this is the measured value used as the basis of performance.  
Similarly, the average zero crossing period (TZ) is used as the basis of the wave period. 
 
Cardno have developed two programs to undertake a Waverider buoy calibration.  The first is a tailored 
version of Cardno’s real time data acquisition and analysis program, OceanSense, and the second is a 
program specific for WRB calibration, LTWaveCal. 
 
For calibrations, a special version of OceanSense has been tailored to read data from a DIWAR receiver, 
DIWAR, or a WAREC, as well as providing wave data analyses at 1 minute intervals rather than the standard 
10 minute interval implemented in the BoM system.  The data intervals have been reduced to allow analysis 
of 256 data points (the Burst Length) in order to speed up the calibration procedure.  Whilst the software is 
setup to analyse 256 points by default, the user may select up to 4096 points.  Both raw and 1 minute 
analysed data is saved to hard disk in a binary format. 
 
LTWaveCal has been written to specifically read data from this version of OceanSense.  LTWaveCal allows 
the user to load data, plot one or many spectra (a spectrum shows the frequency spread of wave energy 
measured by a buoy), and plot a calibration graph.  Once graphs are created, they may be printed or copied 
to the Windows Clipboard for pasting into applications such as Microsoft Word. 
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2.2 Software Installation 

 
The calibration software installation package should be run, all required files will be extracted and installed. 
 

2.3 Collecting Calibration Data 

1) Start OceanSense.  The program will save analyzed wave data to the min1 subdirectory. 
 
2) Connect the RS232 DB9 cable from the DIWAR into comm1 of the computer.  OceanSense should start 

reading the raw data (it should already be setup to read DIWAR data from COM1 at 2400, none, 8, 1.) 
 

- To change comm settings for the DIWAR or WAREC, select File->Logon from the main menu, input 
the password (“lt??99”) in lower case and press enter.   

- From the main menu, choose Configure->Sensors.  Double click on the sensor you are interested in 
and the sensor configuration form will be displayed. 

 

Ensure the non directional buoy being calibrated is Channel 1 (or A) on the DIWAR receiver. 

 
For more information on running OceanSense, see the Technical manual. 
 

3) Run the waverider calibrator at each required frequency for at least 7 minutes.  This will allow the 
calibrator to settle on the correct frequency and OceanSense to analyse a number of wave records at a 
steady frequency.   

 
Using a stopwatch, the actual rotational frequency for each setting should be recorded separately.  If the 
actual rotational frequency is significantly different to the setting on the calibrator, the setting should be 
modified to produce a frequency close to those required. 

 
For compatibility with previous calibrations conducted by BoM, the frequencies to test should be in line 
with those previously used, however if possible it should include those frequencies listed below. 
 
 

 
If the waverider buoy is being used to measure waves of a particular period, it may be necessary to 
conduct additional tests at frequencies closer to this period. 

 
4) Once all required frequencies have been tested, close OceanSense. 
 
5) Before removing the buoy from the calibrator, run LTWaveCal to check data has been collected and the 

calibration curve appears correct with no abnormalities. 
 

Frequency 
(rpm) 

Frequency 
(Hz / rps) 

Period 
(sec) 

2 0.03333 30 

2.5 0.04167 24 

3 0.05 20 

4 0.06667 15 

5 0.08333 12 

6 0.1 10 

8 0.13333 7.5 

10 0.16667 6 

12 0.2 5 

14 0.23333 4.3 

16 0.26667 3.75 
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2.4 LTWAVECAL – Calibration Plotting 

 
LTWaveCal allows the plotting and review of analysed data collected from a waverider buoy mounted in a 
waverider buoy calibrator. 
 
1) Start LTWaveCal. 
 
2) Select File->Open from the main menu. The “File Samples” form (see below) will appear.  By default it is 

setup to read data files from C:\Data\Compound and both start and end dates will default to the current 
day. 

 
Select specific start and end dates as required and click OK. 

 

 
 

3) Assuming data files exist for the date(s) selected, the “Wave Calibration Manager” form will appear.  It 
will automatically read through the min1 data file(s) searching for valid DIWAR (channel 1) data.  The 
valid values will appear in the left hand side ‘Spectrum‘ list box.   

 
If you are calibrating a directional waverider buoy, you should select “Datawell WAREC” from the 
‘Sensor’ list on the top left hand side of the form. 

 

 
 
4) Set the Simulator Height 
 
5) Set the buoy serial number and add any additional notes that may be required. 
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Note - Purpose of Spectra Plots 
As part of the Wave Calibration process, it is possible to plot the full wave energy spectra from each set 
of analysed data.  The wave spectra plot shows the amount of energy that occurred at each frequency 
during the analysis period.  For a Waverider being calibrated, this plot should usually show a single 
narrow, well defined peak at the frequency of revolution (see plot below).   

 

 
 

For a Waverider measuring real data, there may be multiple peaks and energy is likely to be spread out 
over a range of frequencies (see plot below). 

 

 
 

The frequency of revolution of the original BoM calibrator tended to drift during a single calibration, with 
frequency stabilizing for short periods of time before drifting either higher or lower.  For this reason, the 
ability to plot the spectra was required to allow the user to inspect the spectra from one “frequency 
setting”, and choose the “best defined” spectra. 
 
An inspection of data collected by the calibrator showed that the calibrator stabilized quickly, and at a 
constant frequency, with very little or no drift in frequency (see plot below).  Due to this for data 
collected using the new calibrator it may not be necessary to plot multiple spectra from within one 
“frequency setting” to determine the optimum spectra to use as part of the calibration. 
 

 
 

 
6) If spectra plotting is required, select one or many wave analysis records (to select many, hold down the 

Ctrl key and click on the records), then press the “Plot Spectra” button below the complete analysis list to 
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display the spectral graph window (see example plot below).  Any number of Spectral plots can be 
plotted, with any number of spectra in each plot. 

 

 
 
7) By default, the plot scales are set to the minimum and maximum of the data range.  To set the scales to 

user values, either  
- From the main menu select “Options->Spectra Plot”.  This will change the default settings for the 

present and all future plots,  
- Right click on the graph window to bring up a popup menu and choose “Graph Scale”. This will 

change the scale settings for that window ONLY. 
 

 
   
8) If plotting or saving of the spectra is required,  

- Maximize the spectra plot window  
- Right click to display the popup menu (see below).   
- This menu has options to setup the printer (“Printer Setup”), print (“Print”) or copy the plot to the 

Windows clipboard (“Copy to Clipboard”).  Once the plot is copied to the clipboard, it can be pasted 
into other programs such as Microsoft Word. 

 

 
 
 
9) If required, you may zoom-in to an area of interest by left mouse clicking (and holding) at the top/left 

most point of the area of interest and dragging to the bottom/right point of the area, then releasing the 
left mouse button.   

 
To return to full scale,  
- Drag with the left mouse button (same as before) from the bottom/right corner to the top/left and 

release the mouse button, or 
- Right click to display the popup menu (see above) and select “Undo Zoom”. 

 
10) Choose appropriate wave records for calibration.  During the collection of data for calibration, the first 

two or three analyses after a rotation frequency change will contain data from the previous frequency, 
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the changing frequency as the calibrator adjusts, and then the new frequency.  These will be seen by the 
Tz value gradually decreasing (or increasing depending on frequency order) until a similar value is 
reached for a number of analyses timesteps.  Similarly, the wave height may vary before becoming 
steady due to the buoys naturally changing frequency response.  These effects will be seen by 
“smearing” or a double peak in the spectra plot. 

 
A good initial starting point to deciding which analyses are best to use, is to inspect the listing of Tz and 
Hrms, and select analyses where Tz and Hrms have similar values to those of the analyses above them.  
This will be a good indication that the calibrator has stabilized at the correct frequency, and that the 
analysis only contains data from a single frequency. 

 
11) Once appropriate wave records have been chosen, they need to be transferred to the calibration list: 
 

- Highlight the required wave analyses in the full list of analyses (either one at a time or in a group by 
holding the Ctrl key while selecting) in the left hand list box. 

- Click on the “Add” button (between the list boxes) to copy them across to the right ‘calibration’ list, used 
to store the spectral records to be used in the calibration plot. 

 
Repeat this step to add all of the records of interest to the calibration list.  The program will give a 
warning message if an attempt is made to add the following records: 
- the same record as already appears in the calibration list,  
- a record with the same Tz value as a record already in the calibration list. 

 
To remove a record from the calibration list, select the record(s) and click on the Remove button. 

 
12) The figure below shows an example of the “Wave Calibration Manager” once appropriate wave analyses 

have been added. 
 

 
 
13)  Once appropriate wave analyses have been added to the calibration list, click on the “Plot Calibration” 

button to display the calibration curve (see below). 
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14) As with Spectral plots, Calibration plot scales may be changed from the main menu (Options-> 

Calibration Plot) or by right clicking on the plot window and selecting “Graph Scale” from the popup 
menu.   

 
15) As with Spectral plots, a popup menu allows printer setup, printing and copying of the plot to the 

Windows clipboard. It is recommended that a copy of the plot at a standard scale is saved for all 
calibrations.  This will allow easy comparisons of buoy performance over successive calibrations during 
a buoy’s lifetime. 

 
16) As with Spectral plots, it is possible to zoom into an area of interest (see step 9). 
 
17) The Calibration plot has the additional feature of displaying the error % value at 10 seconds when the 10 

second point lies within the calibration curve range. 
 
18) To select new dates for calibration: 

- close the Wave Calibration Manager Form (either from File-> Close or by clicking on the form close 
button [x]),  

- Return to step 2. 
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3 Definition of Wave Parameters  

This section describes the parameters that may be found for each wave buoy in a data log file.  The files that 

each parameter may be found in is listed with the parameter.  Each parameter may be found in the 10 

minute data log. 

3.1 Non-directional Datawell wave buoy 

Water level data is saved every 6 minutes, while all other data is saved every 10 minutes. 
 

PARAMETER DESCRIPTION FILES 

Tide Water Level Average water level measured over the period of the file. 
(Usually at the bottom of the list.) 

Min6 / 
Min10 / 
Raw 

 
Wave Analysis Data 
 

Burst Length Number of data points used in analysis Min10 

Digitising Interval Time interval between data points used in analysis Min10 

Hs Significant wave height measured from the time domain - 
average of highest 1/3rd of all waves in record. 

Min10 

Hrms  td Root mean square wave height from the time domain. Min10 

HMax td Maximum wave in a record (zero upcrossing analysis). Min10 

TZ Zero crossing period from the time domain. Min10 

TS Period of the significant waves. Min10 

TC Crest period. Min10 

THMax Period of the maximum wave. Min10 

EPS td Spectral width from the time domain. Min10 

T02  The period from spectral moments 0 and 2 (=sqrt(m0/m2). Min10 

Tp The period at the peak spectral energy. Min10 

Hrms  fd Root mean square wave height calculated from the spectra 
(=sqrt(8*m0)). 

Min10 

EPS fd Spectral width calculated from the spectral moment 
(=sqrt(m0*m4-m2*m2)/(m0*m4)). 

Min10 

H10 Average of the highest 10% of waves. Min10 
T10 Period of the H10 waves. Min10 
Noise Number of noise errors in the record. Min10 
Nspike Number of spike errors in the record. Min10 

NROC Number of rate of change errors in the record. Min10 

Percent Errors Total percentage of errors. Min10 

SpikeMax Largest deviation from the mean water line, crest or trough. Min10 

ROCMax Largest rate of change between adjacent data points. Min10 

Samax Longest sequence of data points the same. Min10 

Sigma Standard deviation calculated for error checking. Min10 

Nwaves Number of waves (zero upcrossing) in the record. Min10 

TZmax Maximum zero crossing in the record. Min10 

E60 Energy above 0.60Hz (%) Min10 

E04 Energy below 0.04Hz (%) Min10 

Ierr Error Flag: 
 
= 0 all OK 
= 1 max allowable adjacent data pts failed 
= 2 max allowable interpolation distance failed 
= 3 error count > allowable 
= 4 minimum number of waves test failed 
= 5 zero crossing period test failed 
= 6 energy > 0.60Hz test failed 

Min10 
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= 7 energy < 0.04Hz test failed 

M0 Spectral moment 0. Min10 

M1 Spectral moment 1. Min10 

M2 Spectral moment 2. Min10 

M4 Spectral moment 4. Min10 

NORDS Number of banded ordinates Min10 

Banded Ordinate n 
(n=0-127) 

128 banded spectral ordinates. 
 
The significant wave height from the spectra is: 
 4 x sqrt(sum of all energy ordinates x spectral estimate  
   spacing) 
 
Note that there will always be 128 spectral estimates 
irrespective of burst length.  The program will use the 
appropriate banding to provide 128 spectral estimates of the 
frequency range from 0 to the Nyquist frequency. 
 
If a 4096 data point burst length is selected with 1/256 Hz 
digitising interval then: 
 
The Nyquist frequency will be 1.28 Hz 
There will be 8 spectral estimates in each banded estimate. 
The first spectral frequency will be 0.004844Hz (approx) 
The spectral spacing will be 0.01Hz (approx) 

Min10 

 

3.2 Directional Datawell Wave Buoy  

Water level data is saved every 6 minutes, while all other data is saved every 10 minutes. 
 

PARAMETER DESCRIPTION FILES 

Tide Water Level Average water level measured over the period of the file. 
(Usually at the bottom of the list.) 

Min6 / 
Min10 / 
Raw 

 
Wave Analysis Data – OceanSense Calculated 
 

Burst Length Number of data points used in analysis Min10 

Digitising Interval Time interval between data points used in analysis Min10 

Hs Significant wave height measured from the time domain - 
average of highest 1/3rd of all waves in record. 

Min10 

Hrms  td Root mean square wave height from the time domain. Min10 

HMax td Maximum wave in a record (zero upcrossing analysis). Min10 

TZ Zero crossing period from the time domain. Min10 

TS Period of the significant waves. Min10 

TC Crest period. Min10 

THMax Period of the maximum wave. Min10 

EPS td Spectral width from the time domain. Min10 

T02  The period from spectral moments 0 and 2 (=sqrt(m0/m2). Min10 

Tp The period at the peak spectral energy. Min10 

Hrms  fd Root mean square wave height calculated from the spectra 
(=sqrt(8*m0)). 

Min10 

EPS fd Spectral width calculated from the spectral moment 
(=sqrt(m0*m4-m2*m2)/(m0*m4)). 

Min10 

H10 Average of the highest 10% of waves. Min10 
T10 Period of the H10 waves. Min10 
Noise Number of noise errors in the record. Min10 
Nspike Number of spike errors in the record. Min10 

NROC Number of rate of change errors in the record. Min10 

Percent Errors Total percentage of errors. Min10 
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SpikeMax Largest deviation from the mean water line, crest or trough. Min10 

ROCMax Largest rate of change between adjacent data points. Min10 

Samax Longest sequence of data points the same. Min10 

Sigma Standard deviation calculated for error checking. Min10 

Nwaves Number of waves (zero upcrossing) in the record. Min10 

TZmax Maximum zero crossing in the record. Min10 

E60 Energy above 0.60Hz (%) Min10 

E04 Energy below 0.04Hz (%) Min10 

Ierr Error Flag: 
 
= 0 all OK 
= 1 max allowable adjacent data pts failed 
= 2 max allowable interpolation distance failed 
= 3 error count > allowable 
= 4 minimum number of waves test failed 
= 5 zero crossing period test failed 
= 6 energy > 0.60Hz test failed 
= 7 energy < 0.04Hz test failed 

Min10 

M0 Spectral moment 0. Min10 

M1 Spectral moment 1. Min10 

M2 Spectral moment 2. Min10 

M4 Spectral moment 4. Min10 

NORDS Number of banded ordinates Min10 

Banded Ordinate n 
(n=0-127) 

128 banded spectral ordinates. 
 
The significant wave height from the spectra is: 
 4 x sqrt(sum of all energy ordinates x spectral estimate  
   spacing) 
 
Note that there will always be 128 spectral estimates 
irrespective of burst length.  The program will use the 
appropriate banding to provide 128 spectral estimates of the 
frequency range from 0 to the Nyquist frequency. 
 
If 2048 data point burst length is selected with 2/2.56 Hz 
digitising interval then: 
 
The Nyquist frequency will be 1.5625Hz. 
There will be 8 spectral estimates in each banded estimate. 
The first spectral frequency will be 0.002344Hz (approx) 
The spectral spacing will be 0.005Hz (approx) 

Min10 

 
Wave Analysis Data – Buoy Calculated 
 

Elapse Spectral age – time since last DWRB spectra Min10 

Hmo Significant wave height measured from the time domain - 
average of highest 1/3rd of all waves in record. 

Min10 

Tz Zero crossing period from the time domain. Min10 

PkTp The period at the peak spectral energy. Min10 

AveDir Weighted average wave direction Min10 

Pdens Power density at peak Min10 

Jdirn Spectra of 64 wave directions Min10 

Jrpower Spectra of 64 relative power ordinates Min10 

Jspread Spectra of 64 directional spreads Min10 

Wtemp Water temperature Min10 

Rtemp Reference temperature Min10 

Status Status bit Min10 

Vacc Vertical acceleration offset Min10 

Xacc X acceleration offset Min10 

Yacc Y acceleration offset Min10 
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Orient Orientation angle Min10 

Inclin Inclination Min10 

Voltage Battery status Min10 
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4 OceanSense Automatic QAQC Configuration 

Using the water level data from the wave buoy transmission, the OceanSense software carries out two forms 
of wave analysis, Frequency domain and Time domain analysis.  The parameters used to carry out the wave 
analysis are defined in the “Sampling”, “Raw Data”, “Frequency Domain” and “Time Domain” tabs. 

Figure 4.1  DIWAR Receiver – Sampling Tab 

 

4.1 Sampling 

These parameters are used by the software to carry out a wave analysis based on the water level data 
collected by the DIWAR Receiver.  To carry out a wave analysis, a number of parameters related to the 
amount and frequency of data to be used is required.  The user can also select the time at which sampling 
starts and the frequency of wave analysis. 
 

ITEM COMMENTS 

Burst Length Burst length defines the number of points used to carry out a wave 
analysis.  Any power of 2 data points between 256 and 4096 inclusive can 
be chosen.  The smaller burst lengths have been enabled for quick testing 
only. 
 
For DIWAR Receiver, “4096”. 

Digitising Interval The digitising interval is the frequency at which data is received from the 
WRB. 
 
For DIWAR Receiver, “0.39”. 
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Figure 4.2  DIWAR Receiver – Raw Data Tab 
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4.2 Raw Data 

Once the “Burst Length” number of data points have been collected, the data is checked for errors before an 
analysis is carried out. 
 

ITEM COMMENTS 

Consecutive Values the 
same 

Defines the number of consecutive data points of the same value which will be allowed. 
 
For DIWAR Receiver, “11”. 

Data Spike limit The system will initially fit a mean water to the data and calculate a 
standard deviation.  Respond with the number of standard deviations from 
the mean water line considered acceptable as valid data. ie how high can 
a crest be, and how low can a trough be relative to the standard deviation 
of the record. 
 
Note that if the data record is very 'spiky' then this check will become 
corrupted because the spikes will influence the standard deviation.  
 
If a data spike is found the data point is marked for later interpolation. 
 
For DIWAR Receiver, “6”. 

Maximum rate of change Using the same standard deviation calculated above enter the number of 
standard deviations which define the maximum allowable displacement 
between any two adjacent data points.  Again if the burst is 'spiky' the 
check will not work well. 
 
If a data spike is found the data point is marked for later interpolation 
 
For DIWAR Receiver, “5”. 

Maximum Interpolation 
Distance 

The maximum number of adjacent data points distance which can be 
corrected by interpolation.  Allowable responses are 0 to 6. 
 
Linear interpolation is used for single point interpolations. 
 
Parabolic curve fitting is used for 6 point interpolations.  In parabolic 
interpolations the average of two estimates is calculated using the two 
points to the left of the gap and the one point to the right and then vice 
versa. 
 
For DIWAR Receiver, “6”. 
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Maximum percentage of 
interpolations 

The record must have less than the indicated percentage of data errors. 
 
For DIWAR Receiver, “10”. 

 
Figure 4.3 - DIWAR Receiver – Frequency Domain Tab 
 
 

 
Figure 4.4 - DIWAR Receiver – Time Domain Tab 

4.3 Frequency Domain 

After the data has passed through the raw data checking, analysis of the data is carried out.  Further error 
checking of the frequency domain analysis is carried out after this step. 
 

ITEM COMMENTS 

Percentage of Energy > 
0.60 Hz 

The spectra must not contain greater than the indicated percentage of energy above 0.60 
Hz. 
 
For DIWAR Receiver, “25”. 

Percentage of Energy < 
0.04 Hz 

The spectra must not contain greater than the indicated percentage of 
energy below 0.04 Hz. 
 
For DIWAR Receiver, “25”. 
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4.4 Time Domain 

After the data has passed through the raw data checking, analysis of the data is carried out.  Further error 
checking of the time domain analysis is carried out after this step. 
 

ITEM COMMENTS 

Minimum number of 
waves in a record 

If there is less than the indicated number of waves in a burst then the 
burst will be rejected. 
 
NOTE: The maximum number of waves allowed is 900.   If there are 
greater than 900 waves then the time domain analysis will process the 
first 900 waves only.  
 
The frequency analysis (Fast Fourier Transform) will still process the full 
record. 
 
For DIWAR Receiver, “10”. 

Number of zero crossings 
in time limit 

If there is more than this number of zero crossings with a period longer 
than the “Zero crossing time limit (s)” period, then the burst will be 
rejected. 
 
For DIWAR Receiver, “5”. 

Zero crossing time limit 
(s) 

If there is more than the “Number of zero crossings in time limit” value 
with a period longer than the this period, then the burst will be rejected. 
 
For DIWAR Receiver, “30”. 

 

 
Figure 4.5 – Datawell WAREC – Buoy Location Tab 
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5 Technical support  

All technical support inquiries can be forwarded to the following email: 
 
Metocean.support@cardno.com.au 
 
 
Alternatively technical support question can be directed to the following phone number:  
 
(02) 9024 7024 
 
 
 

mailto:Metocean.support@cardno.com.au

